
 للاتصال كاداة الإلكتروني البريد: الثامن الفصل

 الثامن الفصل
 للاتصال كاداة الإلكتروني (البريد٧١

 ؟ الإلكتروني البريد هو ما

 الهاتفية والكالات الرسائل بين إلكتروني تقاطع هوe-mail الإلكتروني البريد

 عنها. الكترونيا نموذجا أو الفاكس ورسائل

 الإلكتروني: البريد خصائص

 ويمكن كتابتها يجب أنه بمعنى العادية الرسائل مثل هي الإلكتروني البريد رسائل ا-

 الهاتفية. الكالة مثل رسمية غير رسائل تكون أن

 الهاتفية الخطوط عبر الهاتفية المكالمات مثل الإلكتروني البريد رسائل إرسال يمكن-٢

 تجمع ثم متعددة مسارات عبر تتجول أن يمكنPackets خزم إلى تقسم لكنها

 وجهتها. مكان في ثانية

 أنه حيث من الهاتفية للمكالة ومغايرة الفاكس مثل هي الإلكتروني البريد رسائل٣

 وهذه للمستلم. الملائم الوقت في وقراءتها للمرسل الملائم الوقت في إرسالها يمكن

 وتتجنب متباعداً للمراسلين الزمني الجغرافي الموقع يكون عندما مفيدة الميزة

 المبيعات مسئول انشغال مثل الرسالة استلامه لدى المستلم انشغال مقاطعة

 مثلا. الزبون مع بنقاش

 فورية وسيلة أنها حيث من الهاتفية الكالة مثل هي الإلكتروني البريد رسائل٤

 مكتوبة. رسالة أنها الوحيد الفرق مع للاتصال
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 الاتصال بحصول الإلكتروني البريد رسائل تسمح لا الهاتفية الكالة خلاف على٥

 والاستلام. الإرسال سرعة رغم والمستلم المرسل بين واحد وقت في الثنائي

 نصا تعالج لا التي العادية الرسالة أو الفاكس مثل هي الإلكتروني البريد رسائل-٦

 التخطيطية. الرسوم تضيف بل فقط واحدا

 نقطة من ترحيلها يمكن أنه حيث من الفاكس مثل هي الإلكتروني البريد رسائل٧

 الأصلية. الرسالة عن واحدة بنسخة الاحتفاظ مع متعددة نقاط إلى أو أخرى إلى

 الهاتفية الكالة أو الفاكس أو العادية الرسالة مثل هي الإلكتروني البريد رسائل٨

 لكن الرسالة. إليه ترسل الذي الشخص عنوان معرفة عليك تفرض أنها بمعنى

 المشترك عنوانهم تعرف عندما الأشخاص من مجموعة إلى رسائل إرسال الممكن من

 الإخبارية بالمجموعات تعرف الأخيرة المجموعة وهذه الفردية. عناوينهم وليس

NewsgrOupSالنقاش ومجموعات Discussion Listsالبريد بواسطة 

 لهم ويسمح الإلكتروني البريد لمستخدمي كبيرة إضافية قوة يعطي مما الإلكتروني

 قبل. من يقابلوهم لم أشخاص مع والآراء المعلومات بتبادل

 لقراءة مكاتبهم أو منازلهم في التواجد الإلكتروني البريد مستخدمي على يكون لا٩

 خدمة بمقدم هاتفياً الاتصال هو لقراءتها إليه يحتاجون ما وكل الرسائل هذه

 عدم يعني الإلكتروني البريد وعنوان معه. يعملون الذي الإنترنت إلى الوصول

 العادي. البريد عناوين في يحصل كما إليه للوصول محدد بمكان الارتباط
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 ميزة لها كبيرة مؤسسات في يعملون الذين المستخدمين إلى الإلكتروني البريد يرسل

 يتم بحيث الطرفية أو الشخصية حواسيبهم إلى مباشرة الإنترنت إلى الكامل الوصول

 أو الحاسوبي المؤسسة نظام إلى دخولهم تسجيل لدى جديدة رسائل وجود إلى تنبيههم

 أما كتابتها. فور الإلكترونية الرسائل إرسال أيضا هؤلاء وبإمكان عملهم. خلال

 البريد في التأخير بعض فيختبرون الإنترنت إلى فقط الهاتفي الوصول خدمة مستخدمو

 لجمع لهم الإنترنت إلى الوصول خدمة بمقدم أولا الاتصال عليهم يكون لأنه الإلكتروني

 من الإلكتروني البريد لاستخدام الاقتصادية والوسيلة الإلكتروني. بريدهم واستلام

 خط خارج الرسائل وكتابة قراءة هي بالإنترنت الهاتفي الاتصال مستخدم جانب

 والدخول قائما( الإنترنت إل الوصول خدمة بمقدم الاتصال يكون لا عندما )أي الاتصال

 الرسائل. وإرسال لاستلام فقط الخط على

 الإلكتروني البريد عناوين

 أجزاء عدة فيه فريد عنوان له الإنترنت على الإلكتروني البريد يستخدم شخص كل

 التالي: مثل

bloggS-i@easYnet.c0.uk  العنوان:

 التالية: الأجزاء إلى مقسم

-]BloggSللمستخدم الحاسوبي الاسم هو 

 في( )موجود تعني@

Fasynet:الإنترنت. على المضيف الحاسوب اسم هو 
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co:أو شركة هي الحالة هذه وفي المضيف الحاسوب تملك التي المؤسسة نوع 

Company.مثل المجال هذا في أخرى رموز توجد ولكن aeو الأكاديمية للمؤسسات 

orgهذه تختلف قد الحكومية، والإدارات للمؤسسات0٧ و التجارية غير للمنظمات 

ac edu وليس  هو الأكاديمية المؤسسات رمز المتحدة الولايات ففي لآخر بلد من الرموز

uk:الولايات باستثناء الإلكتروني البريد عناوين في رموز لها البلدان وكل البلد رمز 

 الإنترنت. فيها بدأت التي الأمريكية المتحدة

 البريد خدمات إلى استنادا وذلك قليلا مختلفة الأخرى العناوين تكون وقد

 العنوان: مثلا الإنترنت. خارج سابقا كانت التي الإلكتروني

compuserve.com@70006.101شركة في الزبائن خدمة عنوان هو 

compuserveالريد الوصول بخدمة والأفراد الأعمال رجال زودت طالما التي 

 الإنترنت. تسهيلات تقديم على فقط مؤخرا عملت والتي البيانات وقواعد الإلكتروني

 الإلكتروني البريد عناوين مصادر

 لاستخدام السريع النمو مع ولكن الإلكتروني البريد لعناوين عدة دلائل تتوافر

 دليلك تجمع أن هو الأفضل والخيار كافية. الدلائل هذه تكون لا قد الإلكتروني البريد

 تلك أو بانتظام تستخدمها التي العناوين بجمع الإلكتروني البريد لعناوين الخاص

 البريد رسائل من العناوين هذه جمع ويمكن لآخر، وقت من لك المفيدة العناوين

business التعريف بطاقات من أو تستلمها التي الإلكتروني cardورجال للشركات 

 بريدهم عناوين على للحصول بالأشخاص بالفاكس أو هاتفيا الاتصال يمكن أو الأعمال

 مقبول. أمر وهذا الإلكتروني
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Netiquette  نيتيكيت

 لك يسمح الفوري الاتصال من شكل هو الإلكتروني البريد فإن قبل من ذكرنا كما

 غير الاتصال هذا على قيود توجد ولكن لرسالتك. السريعة والراجعة السريعة بالكتابة

 محارف تستعمل حيث نيتيكيت أو الإنترنت اتيكيت خلالا من المسموع غير أو المرئي

 مثل: للكلمات إضافية معان لإعطاء خاصة

 بالسعادة. يشعر الكاتب أن تعني)-:

 والغمز. الابتسام )-;تعني

 مثل: الإلكتروني البريد في تستعمل شائعة مختصرات وهناك

AISI:نظري وجهة من وتعني ....

BTW.حال أ على أو.... بالمناسبة وتعني ....

HTHفي هذا يساعد أن آمل وتعني .....

IMHOالمتواضع. رأيي حسب وتعني 

FAOعنها. والإجابة طرحها يتكرر التي الأسئلة وتعني 

FYIلمعلوماتك وتعني ...
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 إلكترونية: رسائل إرسال كيفية

 هما: معلومتين توافر من لابد رسالة ترسل لكي

 إليه. المرسل اسم١

 إليه. المرسل عنوان-٢

 أماكن بعناوين الممتلئة الأدلة من كثير تتوافر إذا للغاية، سهلا أمرأ يعتر وهذا

 مباشرة. إليهم الإرسال يمكنك أشخاص وأسماء

 للإنترنت المستخدمين بأحد خاص لديكAddress عنوان أي أن أي أيضا أشير كما

 مثالا: لكم وسأضرب الوقت نفس في وعنوانه الشخص اسم عن يعبر العنوان هذا فإن

Khaled@hotmail.com

khaled :  وهو العنوان هذا من الأول المقطع هو الشخص اسم

 والعنوان. الاسم بين للربط( علامة وضع ويتم

idsc.g0Y.eg :  هو العنوان أما

 أن: حيث

idsc:بها. يعمل التي المؤسسة اسم هو 

. Government g0٧: حكومية المؤسسة أن معناها

.Egypt eg: الدولة اسم أن تعني

 قد كنت وإذا ويندوز. بيئة في تعمل التي البرامج أحد خلال من يتم وذلك

 فقط للغاية مربحة العملية تلك أن ستجد فإنك قبل من العمل في البيئة تلك استخدمت
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 إليه المرسل عنوان بكتابة قم ثم بذلك الخاصة القائمة من الإلكتروني البريد استدعي

 من لعشرات الرسالة تلك ترسل أن يمكن بذلك فإنك(TO) خانة آخرفي شخص وأي

 ويمكنك تريد ما الرسالة خانة في اكتب ذلك وبعد الجميع يعرف أن أردت إن الأشخاص

 وضع ويمكن واللصق والنسخ القص في ويندوز بيئة في العمل مميزات استخدام بالطبع

Attachment) عمل أيضا ويمكن وخلافه صور file)لهذا ويجوز الرسالة مع مرفق 

 نوع. أ من يكون أن الملف

 النحو على وذلك الإلكتروني البريد عبر الرسائل إرسال خطوات إيضاح ويمكن

 التالي:

. Message>New Message New، عين Mail  زر انقر رسالة، تكتب لكي ا

. Message New  يظهر!خار-٢

Fa٨٥t T Mssyy HbI٣٢٤٧٨٤dt٤ عز

 ا لا يا3 ى٧٤٧٤ إ٠
Aabh pntyded SkNgbPaو e/cyC<ry

± B1 ٧A. }-:- ٤٤٣٤٣ نة==١١٢-٩٥

٢٥٦٥

 وتهن

٣١٣



 للاتصال كاداة الإلكتروني البريد الثامن: الفصل

 الموضوع. سطر أملأ٣

 رسالة. كون٤

send عين>Send زر انقر٥ file Messageاضغط أو Alt+Sيرسل لا وهذا 

. Outbox  إلى يحولها ولكن فعلا الرسالة

: Fk Edt wه٨ Toos M e ssgeي Hb

X ز.4 د Pا .
: Ceate Msl Repy RepyA Forwd Pnt D e teع SrxRec Adيe es fr

[@TH

 سلاء""!ا»

• Muktipls 8ccunts and ldertities

Send an Receive  انقر الرسائل، جميع لإرسال مستعد تكون عندما-1

Outlook يتصلCtrl+M اضغط أو Expressشيء كل ويرسل بالإنترنت 

. Outbox  ل
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 الإلكتروني، البريد استلام

 منزلك إلى أوتوماتيكيا الإلكتروني البريد توصيل يتم لا العادي البريد وبخلاف

 إلكتروني، بريد ما شخص لك يرسل فعندما )الكمبيوتر(. لجهازك الحالة، هذه ­أوفي

 يجب الشخصي. بريدك صندوق في يضعه لذي ا خدمتك، مقدم بريد لخادم يسلم

 الآتي: مراعاة مع وتأخذه1مogon تدخل أن عندئذ

١Outlook Send يتصل and Receive  انقر البريد، صندوق تراجع لكي

Hxpressال في موجودة رسائل أي يرسل ضروريا( كان )إذا بالإنترنت 

Inbox Outbox ال في الجديدة الرسائل توضع جديد. بريد أي ويجلب

 راحتك. على وقراءتها الخروج يمكنك

 تسلمتها. التي بالرسائل قائمة لتزىnbox مجلد عين-٢

6Tmلا 

»١": مم

• MuRIple c urtsع8 aNd Identites

 أسفل فيPreview لوحة في النص وتعرض لتعينها رسالة على مرة انقر٣

 منفصل. إخار في تعرضها لكي مرتين أو الإخار،
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 والإرسال: الرد

lnternet لأن إلكتروني، بريد رسالة على ترد أن السهل من Explorerيقوم 

 الآتي: مراعاة ضرورة مع الصحيح العنوان بإضافة أوتوماتيكيا

Message>reply ا- Reply أوعين  زر انقر ثم عينها رسالة، على ترد لكي

lnternet يفتحCtrl+R اضغط أوSender على Explorerإخار 

.New Message

[TNI

 سة"«

• MuRtiplc acDurs and IdentitiEs

. Subject To سطر وكذلك  سطر ملء بالفعل تم-٢

 الأسفل. الجزء في السابقة الرسالة من النص نقل٣

 السفلي. الجزء من ضرورية غير مواد أ الغي ثم العلوي، الجزء في ردك اكتب-4

 كالعتاد. الرسالة إرسال٥
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 الرسائل: تحويل

 الرسالة، هذه تهمه قد لصديق الإلكتروني البريد رسالة تحويل أيضا يمكنك

 الآتي: اتبع فقط الأصلي الراسل على أفضل يرد أن يستطيع ما لشخص أو

 أوعينForward انقرزر ثم عينها، رسالة، وترسل تحول لكي ا

TO Ctrl+F سطر في الجديد العنوان ادخل Message>Forward اضغط أو

 الرسالة. أرسل ثم المنقول، النص فوق وضعها في ترغب تعليقات أي أضف٢

 التوقيعات:
 ترسل كانت إذا ترسلها رسالة بأخركل ترفق صغيرة نص قطعة هو التوقيع

 شخص تعليق استخدام يمكنك أو اتصالك، تفاصيل على تشتمل فقد العمل، من الرسائل

 ضرورة مع متعبة تصبح الطويلة فالتوقيعات قصيرة، لجعلها تفضلها مأثورة جملة أو

 الآتي: مراعاة

Signatures Tools>Option جدولة وانقر  اذهب توقيع، تعد لكي١

.Add signatures to all outgoing  عين-٢

 لطيف. اسم التوقيع تعطي لكيRename انقر ثم ،New نقر٣

 استخدامه. تريد الذي النص وادخل"Text" عين٤
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 مع التوقيع هذا استخدام وتريد عديدة حسابات لك كان إذاAdvanced انقر٥

 بعضها.

 ه

 د١ا- =ا

1 MGts),0 urea was Crل 

 تنشئها. رسالة كل لنهاية النص يضاف-٦
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 الخاتمة: مجلدات إنشاء

 تريد أخرى رسائل هناك ولكن فوراً، قراءتها بعد استبعادها يمكن الرسائل بعض

 بانتظام، ملفات في تضعها أخر إلكتروني بريد مجلدات إنشاء يمكنك بها. الاحتفاظ

 الآتي: اتبع فقط

.File>Folder>New  لى اذهب جديد إلكتروني بريد تنشئ لكي-١

 اسم. ادخل-٢

Local عين مستوف بأعلى مجلد تنشئ لكي٣ Folderمجلد يكون أن أردته إذا 

 الموجودة. الجلدات أحد عين فرعي،

 المجلدات. لقائمة الجلد تضيف لكي0k انقر٤

 المجلدات أوعين الجديد المجلد داخل رسائل تسحب لكي الماوس استخدم٥

 اذهب ثم الوقت(، نفس في ملف من أكثر تعين لكيCtrl أوshift )اخفض

.Ok Edit>Move وانقر الجلد عين Folder to  ل
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 الإلكتروني، البريد إدارة

 هي: الإلكتروني للبريد مجلدات خمسة أساسا لديك يوجد

Drafts, Deleted Items, ltems, Outbox, Inbox

Inbox  في الجديد الإلكتروني البريد يوضع ا-

Outbox  في الخارج البريد ينتظر-٢

Sent مجلد إلى فوراً تنتقل الرسالة، ترسل عندما٣ ltemsتحتفظ وبذلك 

 بنسخة.

Delete Edit>Delete، اضغط  ونقرت رسالة عينت إذا٤،Delet، عين

Deleted مجلد في وتنتهي ،Ctrl+D اضغط أو ltemsمن انقاذها يمكنك 

 ضروريا. كان إذا الإلغاء

Outlook يسألك إرسالها، بدون رسالة أغلقت إذا٥ Expressتريد كنت إذا 

 أخرى مرة بها العمل فيمكنكDrafts لجدد تنتقل ،Yes نقرت إذا حفظها

 بعد. فيما
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 الإلكتروني، البريد تصنيف

Outlook يقوم كما Expressيمكنك المجلدات، هذه في الإلكتروني البريد بوضع 

 مجلد. كل في الرسائل تصنيف من أيضا

 القائمة. بأعلى الموجودة الرمادية الفئات جدولات إحدى انقر الرسائل، تصنف لكي

 التصنيف. تعكس لكي أخرى مرة انقر

[@TTT

 الإلكتروني للبريد عامة بروتوكولية قواعد

 البريد استخدام لدى إتباعها يجب التي العامة البروتوكولية القواعد بعض نورد وهنا

 وه· الإلكتروني

 حسن من ويعتجر أسهل. قراءتها يجعل ذلك لأن صغيرة بأحرف الطباعة ا-

 الإلكتروني. البريد استعمال لدى التصرف
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 وصول أن حيث العلاقة، صاحب الشخص إلى الصحيحة الرسالة بث من التاكد-٢

 والإحراج. للمتاعب سبباً يكون قد الخطأ الشخص إلى رسالة

 بذيئة. رسالة أية بث عن الامتناع٣

 متناغمة. لطيفة قصيرة، الرسائل لتكن٤

 الإلكترونية: الرسائل وبث كتابة عند مراعاتها ينبغي القواعد من جملة وهناك

 مختصرة. الرسالة تكون اأن

 الرسالة متلقي يجعل ما التوضيحية بالرسومات مليئة وغير بسيطة تكون أن-٢

 رموزها. فك في أكبر جهدا يبذل

 رسائلك فيه تحفظ الذي العنوان أو الإلكتروني، بريدك صندوق مراجعة-٣

 بسرعة. عليها والرد بانتظام الواردة

 هذه بمثل الالتزام عدم أن إذ والهجاء والصرف والنحو اللغة قواعد مراعاة٤

 الشركة. عن سيئا انطباعا يعطي الأمور

 النقاش ولوائح الإخبارية المجموعات

 وأنت عملك وغبيعة اهتماماتك في يشاركونك آخرين مراسلة تريد أنك لنفرض

 إلى بالانضمام لك يسمح الإلكتروني البريد هنا عليهم. العثور مكان من متأكداً لست

Discussion نقاش لوائح أوNewsgroup إخبارية مجموعات Listsيتبادل حيث 

 الأسئلة بعضهم ويسألون الجديدة التطورات في ويتناقشون والثرثرة الأخبار الأشخاص

 عنوان إلى رسالة بإرسال هذا كل فعل ويمكن الآخرين. إلى والنصائح المعلومات ويرسلون
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 والحصول المجموعة في فرد كل إلى الرسالة تمرر بحيث المجموعات لهذه الإلكتروني البريد

 المجموعة من جزءاً تكون أن ويمكنك المجال. هذا في الآخرين رسائل كل على بالقابل

 رسائلهم وقراءة الآخرين لآراء فقط مستمعا تكون وأن تريده وقت لأي مجموعة وأي

 إليهم. الرسائل إرسال بنشاط الاشتراك أو

: News Group  الإخبارية المجموعات

 إل الوصول خدمة مقذمي برامجيات معظم في المجموعات هذه لوائح تظهر

 أنه تحذر أن يجب ولكن فيها. الاشتراك ترغب التي المجموعة اختيار ويمكنك الإنترنت

 اليوم في الرسائل مئات أو عشرات ستصلك المجموعات هذه إحدى ضمن اشتراكك فور

 التي البرامجيات وحسب البداية. في كثيرة مجموعات في للاشتراك كثيراً تتحمس لا لهذا

 خدمة مقدم حاسوب من نزولا الواردة الرسائل كل تحميل إما يمكن تستخدمها

 بالرسائل لائحة مراجعة أو نظامه، إلى دخولك تسجل مرة كل في الإنترنت إلى الوصول

 بالتفصيل. قراءتها تريد التي الرسائل تلك فقط تحميل واختيار ما وقت في المتوافرة

 الإخبارية المجموعات عن أمثلة

 والعلمية. الربوية الأبحاث مجموعات

 والتجارة. الأعمال برجال الخاصة الندوات مجموعات

 التقنية. والمساندة الإدارة مجموعات

 التجارية. الاستشارات مجموعات

 واللهو. التسلية مجموعات
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: النقاش لوائح

 الإخبارية المجموعات من تخصصا أكثر وهي مختلفة بطريقة اللوائح هذه تعمل

 هذه النقاش مجموعات تخضع ما وغالبا والأشخاص. الأفراد من أقل عددا وتتضمن

 وهذه وتوجيهها. النقاش لائحة في الواردة المواضيع ضبط على يعمل شخص لإدارة

 أفراد من القادمة المستحبة غير والإعلانات المستحبة غير المواضيع لاستبعاد وسيلة

 بعض مطلقو يتلقى الأحيان بعض وفي خدماتها. أو منتجاتها بيع في ترغب شركات أو

 كانت وإذا ترحيب موضع ليست رسالتهم بأن إجابة اللائحة على الإعلانات أو المواضيع

 النقاش. بلائحة المسئول الحاسوب اتصال يقطع النوع هذا من الرسائل كل

 ترغب التي واللجان والهيئات الاجتماعية للنوادي جيداً منتد تعد النقاش ولوائح

 وتبادل الآخرين واجتماعات اجتماعاتها محاضر واستلام بينها اتصال على الإبقاء في

 المعلومات.

 النقاش، لوائح عن أمثلة

bprالتجارية. الهندسة 

hrnetالبشرية. الوارد شبكة 

Learning-org.التعليم 

leadershipوالزعامة. القيادة 

management-researchالإدارية. الأبحاث 

Trdev-1والتنمية. التدريب 

telework:البعيدة. الاتصالات 
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The Directory of Scholarly  هو النقاش لوائح إلى الرسمي والدليل

Flectronic Conferencesالإنترنت. عبر التوافر 

 الإلكتروني: البريد وسلبيات إيجابيات

 الإلكتروني، البريد إيجابيات

 العادي. البريد من أسرع التسليم4

 من ليس حيث العالم في للمنا&ق الزمنية الفروقات يتجاوز الإلكتروني البريد

 الرسالة. لتسلم حاضراً المستلم يكون أن الضروري

 البريد عبر وسهلة بسيطة كثيرين أشخاص إلى واحد شخص من المراسلة م

 الإلكتروني.

 للانتقال. قابل أو منقول الإلكتروني البريد عنوان

 التعرف لك يسبق لم أشخاص مع المعلومات بتبادل لك يسمح الإلكتروني البريد

 إليهم.

 استخدامها. إعادة يسهل إلكتروني بشكل المعلومات نقل م

 الرسالة. تقطعها أن يجب التي السافة على الإلكتروني البريد كلفة تعتمد لا

 الفاكس. أو الهاتفية الكالات كلفة من بكثير أقل الإلكتروني البريد كلفة م

 مباشرة. الإلكتروني البريد رسائل عن الإجابة4
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 الإلكتروني، البريد سلبيات

 وقراءتها. الرسالة اعتزاض كان لأي يمكن حيث كثيرا آمنا ليس الإلكتروني البريد4

 زائد. بشكل استعماله أو الإلكتروني البريد استعمال إساءة تحصل أن يمكن4

 وهذا الفورية الإجابة على يحث قد أنه بمعنى فورية ميزة له الإلكتروني البريد٩

 العادي. البريد في يحصل لا ما

 ليس آخرين لأشخاص بريد علبة الإلكتروني البريد صاحب يصبح أن يمكن

 الإلكتروني. البريد في حسابا لديهم

 لاحقا. عليها تندم قد سريعة إجابات على الإلكتروني البريد يشجع

: خلاصة

 وسلبياته واستعمالاته الإلكتروني البريد عمل كيفية في اليوم نظرنا لقد

 على للعثور وسيلة هو اتصال وسيلة كونه جانب إل الإلكتروني والبريد وإيجابياته.

 الإنترنت. عبر المعلومات على للعثور أخرى وسائل في يلي فيما ننظر وسوف المعلومات.
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 الإلكتروني التفاوض

 والآراء الأفكار وتبادل والمناقشة التحاور عملية عامة" بصفة بالتفاوض يقصد

 ما مصلحة حول معين اتفاق إلى الوصول أجل من الأخراف بين بالتفاعل والمساومة

""(. ما لشكلة أوحل

 بوسائل منها جزء أو بالكامل تتم هذه التحاور عملية كانت إذا أنه ويلاحظ هذا

 التفاوض اسم عليه يطلق هنا التفاوض فإن الإلكتروني بالتسجيل أو إلكترونية

 الإلكتروني.

 معا الطرفين عاتق على تبادلية التزامات يرتب حيث للجانبين ملزم عقد أنه كما

 بحسن وإدارتها المفاوضات في بالاستمرار اتفاقياً التزاما هرف كل عاتق على ينشى حيث
 نية.

 والتنفيذ: الإبرام حيث من

 التواجد بدون أي لوجه، وجها الطرفين حضور بدون التفاوض عقد إبرام يتم

 فلما التنفيذ، حيث من أما بعد، عن تتم التي العقود من فهو ثم ومن لطرفيه، المادي

 نية، بحسن المفاوضات في الدخول مجرد هي الطرفين على المفروضة الالتزامات كانت

 شبكات عبر النهائي العقد حول والمقترحات الآراء تبادل غريق عن بالفعل يتم ما وهو

 بالكامل تم قد يكون الإلكتروني التفاوض عقد تنفيذ فإن ثم ومن الإلكترونية، الاتصال

 عقد وينفذ يرم أن الجائز فمن ولذلك الافتراضي، العالم وفي الإنترنت شبكة خلال من

 النهضة دار البيئي، السياحي الأكثر النوعي، الخاص الدولي القانون سلامة، الكريم عبد أحمد "د.

٠٦٢ ص ،2٠٠٠ القاهرة، العربية،
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 ودون إلكتروني وسيط خلال ومن الإنترنت شبكة عبر بالكامل الإلكتروني التفاوض

 الملموس. المادي العالم إلى الخروج إلى الحاجة

 باسم يعرف ما خلال من الإلكترونية المفاوضات تتم ما وغالبا هذا

 الدردشة(. )غرف

 للعقد المختلفة الشروط ومناقشة وبحث إعداد يتضمن الإلكتروني والتفاوض

 نهائي. اتفاق في وبلورتها النهائي

 المفاوضات لتأمين الإلكتروني التفاوض مرحلة في ولاسيما عادة الأخراف يلجاً وقد

 وذلك للمفاوضات، اتفاقي تنظيم وضع إلى النهائي العقد إلى التوصل فرص وزيادة ذاتها

 وإيجاد المفاوضات تسهيل بهدف التفاوض لعملية المنظمة العقود بعض إبرام خلال من

 بالتزاماته منهما أي إخلال على يرتب بحيث الطرفين، بين للتفاهم مشركة أرضية

 تعاقدية. مسئولية التفاوضية وتعهداته

 نفس في لكنها التعاقد عملية على سابقة التمهيدية العقود هذه أن من الرغم وعلى

 الطرفين"". بين التزامات وترتب نهائية عقود تعتبر الوقت

 يسبق فقد الطرفان، إليه يرمي الذي الهدف لتنوع تبعا العقود هذه صور وتتنوع

 للحفاظ الأمر يقتضي وقد التمهيدية، العقود من مجموعة إبرام النهائي العقد إعداد

 مؤقتة عقود إبرام المتوقعة للمشاكل حلول ووضع المفاوضات، سير حسن على

 مرحلة أثناء خرف كل عاتق على الواقعة الالتزامات تحديد بهدف بروتوكولات أو

 الإلكتروني. التفاوض عقد على الضوء نلقي سوف والآن التفاوض،

.٤٣ ص سابق، مرجع العقدية، للمفاوضات الاتفاقي التنظيم العال، عبد حسين محمد "د.
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 الإلكتروني، التفاوض عقد

 المفاوضات، صور من صورتين بين التفرقة إى الفقه" في المعاصر الاتجاه يجري

 التي المفاوضات تلك بها ويقصد تفاوضي، باتفاق المصحوبة غير المفاوضات هي الأولى

 تقوم ولا مادي، عمل مجرد تعتبر وهي ينظمها، صريح اتفاق هناك يكون أن دون تتم

 اقترن إذا التقصيرية المسئولية أساس على إلا عنها العدول حالة في المتفاوض مسئولية

 المصحوبة المفاوضات هي والثانية: الآخر، بالطرف ضرراً ألحق مستقل بخطاً عدوله

 وفي الطرفين، بين صريح اتفاق على بناء تتم التي المفاوضات تلك أي تفاوضي، باتفاق

 علاقة لوجود قانونيا تصرفا المفاوضات هذه وتعتبر مكتوبا، الاتفاق هذا يكون الغالب

 تعاقدية. مسئولية عنها الناشئة المسئولية تكون ثم ومن الطرفين، بين تعاقدية

 لأنه عقدية""، ذوغبيعة دائما هو التفاوض اتفاق أن إلى السابق الرأي وينتهي

 اتفاقا بينهما فيما عقدا قد الطرفان يكون التفاوض، في بالدخول الرضاء بمجرد

 عن التفاوض عن الناشئة المسئولية يجعل الذي هو الاتفاق وهذا التفاوض، على تمهيديا

 عقدية. خبيعة

 بين قانوني تصرف فهو آخر عقد أي عن تعريفه في التفاوض عقد يختلف لا

 توافر سوى وصحته لوجوده يتطلب ولا معين، قانوني أثر ترتيب بهدف طرفين

 من يعتبر وهو والسبب، والمحل الرضاء وهي عامة، بصفة للعقود المقررة الشروط

 قانونا. المنظمة وغير نسبيا الحديثة العقود

 العقد الليل، أبو الدسوقي هيم إبر د. ،٨0 ص سابق، مرجع الالتزام، مصادر الأهوني، الدين حسام ""د.

 مرجع العال، عبد حسين محمد ،د.١٠٥ ص ،١٩٩٥ الأولى الطبعة الكويت، جامعة المنفر.ة، ولإدارة

.٩٢ ص سابق،

.٢٨٧ ص سابق، مرجع اللاه، عبد كريم رجب "د.
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 عقد بأنه" التفاوض عقد الدولية التجارة بغرفة التحكيم محكمة عرفت وقد

 لم معين عقد إبرام إلى التوصل أجل من بمتابعته أو بالتفاوض طرفاه يتعد بمقتضاه

""". لانعقاده الأحوال جميع في يكفي لا جزئي بشكل إلا موضوعه يتحدد

 ببدء خرفاد يتعهد بمقتضاه عقد بأنه" تعريفه إلى الفقه بعض ذهب وقد

 في عقد إبرام إلى التوصل بغرض المفاوضات، سير تنظيم أو متابعته أو التفاوض

 شخص بمقتضاه يلتزم اتفاق" بأنه تعريفه ال آخر جانب ذهب كما المستقبل"

. إبرامه بهدف معين عقد بشان التفاوض ي الاستمرار أو بالبدء أخر شخص تجاه

 الطرفين على التزاما يرتب التفاوض عقد أن السابقة التعريفات من ويتضح

 النهائي. العقد بإبرام التزاما يتضمن أن دون فقط، نية بحن التفاوض بمواصلة

 شبكات عبر يتم أنه في إلا العقد، هذا عن الإلكتروني التفاوض عقد يختلف ولا

 الإلكترونية الرسائل تبادل غريق وعن الإنترنت، أشهرها ومن والمعلومات الاتصالات

 الاتصالات بشبكات المتصلة الفيديو كاميرات خلال من أو الإلكتروني، البريد باستخدام

 الإنترنت. عبر المحادثة أو الدولية،

 تحفظ صورة في يرد أن الغالب ولكن مستقلاً، يكون قد الإلكتروني التفاوض واتفاق

 تحفظا والتجارية الصناعية العقود تتضمن قد حيث ، آخر" عقد يتضمنه شرط أو

 هذا أثر على العقد بتعديل يسمح عليها التعاقد تم التي الاقتصادية الظروف تغير ضد

 شرط الآلي الحاسب عقود تتضمن قد كما الجديدة، للظروف ملائما وجعله التغير،

.٩٧ ص سابق، مرجع سلامة، الكريم عبد أحمد »د.

.٩4 ص سابق، مرجع العال، عبد حسين محمد "اد.
'Oliver lteanu, Lnternet et Le Dirot. Op. Cit., P. 79.

.١٠٠ ص سابق، مرجع العال، عبد حسين محمد 'د.
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 في تستدعي العقود فهذه كبيرة، وعملية علمية أهمية من عليه تنطوي لما التفاوض

 ما تنفيذ كيفية وتحديد تفاصيلها لضبط التفاوض اتفاق إبرام الأحيان من كثير

"". ومستقبلية آنية متطلبات من بها يرتبط وما مراحل من تحويه

 التفاوض: عقود خصائص

 محكمة به قضت ما عكس وعلى الفقه"، من جانب يرى حقيقي، ا-عقد

 على إرادتين بتوافق فهويتم مادية، عملية مجرد وليس عقد التفاوض إن النقض"،

 منه. القانوني الأثر إحداث

 والمحل الراضي وهي عام، بوجه عقد لكل اللازمة الانعقاد أركان فيه تتوفر كما

 التفاوض، في الدخول على الطرفين بين التزاضي يتم أن لانعقاده فيكفي والسبب،

 ويقوم الآخر، الطرف إلى للتفاوض دعوة بتوجيه الطرفين أحد يقوم بأن ذلك ويتحقق

 للتفاوض أهلا غرف كل يكون وأن مطابقا""، قبولا الدعوة هذه بقبول الأخير هذا

 العيوب. من خالية وإرادته

 في ولاتفاق التفاوض بين التفرقة وهمية للتعاقد الممهدة ولاتفاقات العقود نكاس، فاخر جمال "د.
٠١٦٩ ص سابق، مرجع التعاقد، على السابقة المرطة
.٥٩١ ص سابق، مرجع اللاه، عبد كريم رجب د.٠٤٩١ ص سابق، مرجع بدوي، بلال 'د.

 ا،٨ س سنؤت خمس في النقض أحكام مجموعة ،١٩٦٧ فبرير٩ جلسة٢ رقم نقد "طعن
 بذاتها عيها يترتب ولا مادياً عملاً غلا ليست المفاوضات" بأن النقض محكمة قضت حيث ،٣٣٤ ص
 لأية يتعرش أن دون يريد الذي الوقت في المفاوضة قطع في حر متفاوض كل ون قانوني، أثر أي

 للطرف ضرر عنه نشأت إذا التقصيرية المسئولية معه تتحقق خطاً بالعدول اقترن إذا غلا مسئولية
 الآخر.
 مصادر الله، عطا محمد برهام د. ،٨٠ ص سابق مرجع الأهوني، الدين حسام د. من كل لدى إليه مشار

.١٨١ ص سابق، مرجع شاهين، شوقي محمد د.٠١٦٥ ص ،٢٠٠٠ ناشر، بدون الالتزم،
.١٠٢ ص سابق، مرجع العال، عبد حسين محمد "(د.

٣٣١



 للاتصال كاداة الإلكتروني البريد الثامن: الفصل

 في بالدخول الرضاء عن التعبير يجوز أنه العامة، للقواعد غبقا المقرر، من كان وإذا

 من قانونا يمنع ما يود لا فإنه عرفا، المتداولة بالإشارة أو بالكتابة أو باللفظ التفاوض

 إلكترونية. بوسائل ذلك يتم أن

 أما النهائي، العقد إبرام إلى التوصل محاولة هو ومحله العقود، كسائر محلا له أنه كما

 وهو منه لقصوده خرف كل وتحقيق النهائي العقد إتمام فهو التفاوض عقد في السبب

 مشروع"". عقد بشأنه المتفاوض العقد أن ماkخ مشروع باعث

 خويلة فترة والعقدة الهامة للعقود بالنسبة التفاوض يستغرق قد مؤقت: -عقد٢

 المفاوضات، سير عرقلة إلى يؤدي مما الصعوبات من الكثير تعتريها وقد الوقت، من

 العقد على التفاوض تنظيم إلى تهدف المدة محددة عقود إبرام إلى الطرفان يلجاً ولذلك

 بحيث التفاوض بفترة زمنيا محددة لأنها نظراً المؤقتة بالعقود تعرف المنشود النهائي

 الفترة. هذه بانتهاء تنقضي

 التفاوض في الطرفان يستغرقها التي هي المدة وتلك محدودة، لدة إلا يوجد لم فهو

 إلى بالتوصل سواء الطرفين بين المفاوضات انتهت فإذا الإلكترونية، الاتصال شبكة عبر

 عدم مع وذلك التفاوض، لعقد أثر كل زال المفاوضات فشل أو المنشود النهائي العقد إبرام

 نية. بسوء المفاوضات قطع نتيجة الغير بحقوق الإضرار

 أ من يمنع ما ثمة ليس أنه إلا المدة محدد غير الغالب، في كان، وإن التفاوض وعقد

 للتفاوض"". معينة مدة الطرفان يحدد

.١٠٣ ص السابق، المرجع"
.٩٩ ص سابق، مرجع سلامة، الكريم عبد أحمد "»د.
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 للاتصال كاداة الإلكتروني البريد: الثامن الفصل

 أحد عاتق على ينشئ الذي الاتفاق" بأنه المؤقت العقد هذا تعريف يمكن ثم ومن

 العقد على التفاوض أثناء العلاقة لتنظيم مؤقتة التزامات كليهما أو الطرفين

""". النهائي

 الالتزامات هذه ومن مضمونها، لتنوع تبعا متنوعة التزامات المؤقت العقد وينشئ

 الأسرار على المحافظة على والاتفاق ثالث، غرف مع التفاوض إجراء بعدم الالتزام

 نفقات بسداد والالتزام التفاوض، عقد بمناسبة الطرفان عليها اغلع التي والمعلومات

 التفاوض. في النية حسن بمبدأ والالتزام المفاوضات، فترة أثناء أجريت التي الدراسات

 تمهيد إل يهدف وإنما ذاته، في مقصوداً عقداً ليس التفاوض فعقد تمهيدي: -عقد٣

 تمهد التي المفاوضات مسيرة تبدأ العقد هذا بموجب حيث "، النهائي العقد أمام الطرق

 النهائي. العقد لإبرام

 بالتفاوض قانوني التزام يوجد لا أنه الإرادة سلطان لبدأ وفقا القاعدة كانت وإذا

 على التزاما ينشئ الإلكتروني التفاوض لعقد التمهيدي الطابع أن إلا ما، عقد لإبرام

 ببذل التزام وهو النية""، حسن لمقتضيات وفقا فيه والسير بالتفاوض خرف كل عاتق

 يوجب عقدياً خطأ به الإخلال يشكل الالتزام وهذا نتيجة، بتحقيق وليس عناية

 ما يوجد فلا النهائي. العقد بإبرام الطرفين على التزاما ينشئ لا أنه إلا المسئولية،

 وتكملته. الاتفاق عقد بتأييد يلزمهما

( Mousseron. Laduree dans l aformation des contrats.art.prec.p.516.

.٤٩٦ ص سابق، مرجع الله، عبد كريم رجب د. لدى إليه مشار-

.٤٩٢ ص سابق، مرجع بدوي بلال "د.

.٤٨٧ ص سابق، مرجع اللاه، عبد كريم رجب "د.

٣٣٣



 للاتصال كاداة الإلكتروني البريد الثامن: الفصل

 غبيعة له نهائيا حقا خرفيه من أيا يخول لا التفاوض لعقد التمهيدي الطابع وهذا

 سلطات من يقيد عينيا حقا ينشئ لا أنه كما عينياً، أم شخصيا حقا أكان سواء مالية،

 حرية من تحد أفضلية أو أولوية ميزة يرتب ولا التفاوض، موضوع الشيء على المالك

 أكان سواء الشيء على الحجز لتوقيع أساسا يصلح لا كما الشيء، هذا بشأن التفاوض

 تنفيذيا"". أو تحفظيا حجزا

 المراد للعقد الجوهرية المسائل على يشتمل لا التفاوض عقد أن بالذكر والجدير

 دون المفاوضات سير وتنظيم الآراء وتبادل المناقشة مجرد على دوره يقتصر إذ إبرامه

 إظهار لمجرد يرم لا النهائي العقد أن كما إبرامه. المزمع النهائي العقد لشروط التعرض

 وشروط عناصر على جديد تراضي يلزم بل التعاقد في رغبته التفاوض خرفي أحد

 النهائي. العقد

 في رغبتهما عن التفاوض خرفا يعبر أن يشترط فلا للجانبين: ملزم رضائي عقد٤

 لو حتى وذلك رضائياً، عقدا التفاوض عقد ويظل معين، بشكل العقد هذا في الدخول

 ثم ومن شكلي"، عقد هو المفاوضات نهاية في إبرامه والمراد المنشود النهائي العقد كان

 العملية في الدخول على الإيجاب مع القبول بتوافق يتم الإلكتروني التفاوض عقد فإنه

 العقد. يقوم حتى فيها والسير الإلكترونية، الاتصال وسائل عبر التفاوضية،

 بعدها. وما ا١٠ ص سابق، مرجع العال، عبد حن محمد اد.

.٤٩١ ص سابق، مرجع بدوي، بلال »د.

٣٣٤



 للاتصال كاداة الإلكتروني البريد: الثامن الفصل

 للتفاوض: كأداة الدردشة غرف

Microsoft برنامج استخدام إلى اللجوء هنا ويفضل Chat"أسهل من أنه حيث 

 الدردشة برامج من العديد منك تتطلب فبينما توافراً. وأكثرها الاستخدام في البرامج

 تريد. ما لتنفيذ الأوامر بسطر كلها وكتابتها الأوامر من مجموعة تحفظ أن الأخر

Microsoft يعمل Chatلسهولة بالإضافة والقوائم. الرموز الأزرار. غريق عن 

 كوميدية صورة في الدردشة عرض الممكن فمن فريدة، إمكانية يقدم فهو الاستخدام

 مجرد. كنص عرضها من بدلا

Microsoft ويأتي هذا Chatخدمة بوحدات ما حد إلى قصيرة قائمة وبه 

IRC  عالم واستكشاف للبرامج المزيد إضافة تستطيع أنك إلا بالفعل، المثبتة الدردشة

.Undernert, Dalnet  نظام مثل الخدمة وحدات خلال من

Chat Connection Microsoft الحوار مربع يظهر Chat  تشغيل في تبدأ وعندما

 ملأه: عليك يجب واحد حقل يوجد حيث الشخصية البيانات بعض تقديم يلزمك أولا

 الإلكتروني بريدك وعنوان الحقيقي، الاسم كتابة يمكنك اختياريا، مستعار( )اسم

 لك. مختصر ووصف بك، الخاصة الرئيسية الويب للصفحةURL ال

 على الأسهل من كان كلما تقدمها التي البيانات زادت كلما أنه ملاحظة مع هذا

 التي الكتب نوع ، هواياتك إضافة في ترغب وقد الحديث. وبدء منك الاقتراب الآخرين

 ترك دائما يمكنك نفسك، عن البيانات من الكثير عن الإفصاح تجنب أردت وإذا تقرأها،

Microsoft يقدمها التي الشخصيات وتمثل فارغة، الربعات هذه Chatونساء رجال 

 ،٢٠٠٠ القاهرة، ولتوزيع، للنشر الفاروق دار الإنترت، نفسك علم وخرون، كرو، ديفيد"
 بعدها. ومما ا٨٠ ض

٣٣٥



 للاتصال كاداة الإلكتروني البريد الثامن: الفصل

 بالنقر والتعبير الوضع تغيير ويمكنك الكارتونية. الأشكال بعض إلى بالإضافة مختلفين

 الرئيسية، بالشاشة الوجه دائرة ستجد كما الشكل. أسفل بالوجه الخاصة الدوائر على

 المحادثة. أثناء يتغير أن الممكن -فمن الآن واحد تعبير لاختيار داعي فلا

 تقضي فلا الكوميدية. الشخصيات عليها تظهر التي الخلفية تحديد تستطيع كما

 بعد فيما قليلة ثوان في تغييرها دائما يمكنك حيث اختياراتك. ضبط في خويلا وقتاً

 الآن الاتصال ويمكنك بالإنترنت، الاتصال قبل بذلك القيام عليك لكن أردت، كلما

 كل في الشخصية على تجريها التي التغييرات حفظ سيتم بأنه علما بعد، فيما أو

 الأحوال.

 شرحه. تم لما العملي التطبيق توضح التالية والأشكال

.Rersonal Info  علامة على بالماوس انقر ا-

 مطلوب(Nickname) خانة املأ-٢

 شئت. إذا الأخرى البيانات أملأ٣

٣٣٦



 للاتصال كاداة الإلكتروني البريد: الثامن الفصل

.Character  علامة انقر٤

 شخصية. لتحديد الأسماء انقر٥

Background  التبويب علامة انقر-٦

 خلفية. لتحديد الأسماء على انقر٧

٣٣٧



 للاتصال كاداة الإلكتروني البريد الثامن: الفصل

 الدردشة. خدمة بوحدة للاتصالOk زر انقر٨

 بالإنترنت. متصلا لست بأنك إبلاغك سيتمCancel زر انقر خياريا،٩

 الشاشة. لسحOK زر انقر-١٠

 الدردشة: خدمة بوحدة الاتصال

Microsoft يمكنك Chatكانت سواء دردشة، خدمة وحدة بأي الاتصال من 

 مع تعمل لا خدمة وحدة اخزت إذا وبالطبع، لا. أم الكوميدية الأشكال بتنسيق تعمل

Microsoft Chatيزال لا أنه إلا الكوميدية، الشخصيات استخدام تستطيع فلن 

 علما باختياره. قمت الذي الاسم استخدام سيتم حيث للمحادثة. الانضمام بإمكانك

 عادة تتناول منها كل الدردشة، حجرات من العديد لديها خدمة وحدة كل بأن

 مختلفا. موضوعا

٣٣٨



 للاتصال كاداة الإلكتروني البريد: الثامن الفصل

Chat Microsoft الحوار مربع سرى مرة، لأول Chat  بتشغيل تقوم كنت وإذا

Comnectionالتبويب علامة تحديد تم وقد Connectوإذا بالشكل، موضح هو كما 

 المربع. لهذا للوصولConnect زر على النقر يلزم بعد، بالإنترنت تتصل لم كنت

 زيارتها. تريد التي الدردشة حجرة اسم بالفعل تعرف كنت وإذا بأسفل. زرين وسنرى

Go زر اترك to chat roomأما بالمربع، الدردشة حجرة اسم واكتب هو كما محددا 

show all  زر حدد الخدمة، بوحدة الحجرات قائمة على الاغلاع تفضل كنت إذا

. available chat rooms

 ما والآن بينها. من لتختار مختلفة خدمة وحدات أربع وبه البرنامج ياتي ثم ومن

 وحدة استخدام تريد تكن لم إذا أحدها وتحديد المنسدلة القائمة على النقر سوى عليك

 دائم. بشكل للقائمة إضافتها وسيتم خدمة

Message إل ستصل ، بالاتصال تقوم عندما of the dayالأمر يقتصر حيث 

 تحب كنت إذاMicrosoft من وتنازل الخدمة لوحدة الإحصاءات من قائمة على

 القائمة. هذه على للاخلاع فسيناسبك البيانات، من النوع هذا ومثل الإحصاءات

 مربع خيار تحديد بإلغاء قم بالاتصال، فيها تقوم مرة كل في رؤيتها في ترغب لا كنت إذ

. Show this wherever comnection

 سبق: ما إيضاح في تسهم التالية والرسومات

٣٣٩



 للاتصال كاداة الإلكتروني البريد الثامن: الفصل

.Conneet  زر انقر بالإنترنت، متصلاً تكن لم إذا-١

 الاسم. اكتب تريدها، التي الدردشة حجرة اسم تعرف كنت إذا-٢

Show this.الدردشة خدمة بوحدة الحجرات قائمة على للحصول٣ 

. wherever connection

 حدمه. وحده اي وحدد المنسدله القائمه انقر٤

 الدردشة. خدمة بوحدة للاتصالOK زر انقر٥

٣٤٠



 للاتصال كاداة الإلكتروني البريد: الثامن الفصل

 الحالة. بشرط الاتصال في التقدم ينظر-٦

Message تظهر٧ the Dayزر انقر OKالحجرات. قائمة لعرض 

%}yrj44 يg¥4i٦ي 
HaFزنيا ب5 ا 

yبf} r يذح  ا4 يم١ ا1 جيزة

tو ي! cot،yبي1ينهب ج a4nو Mر ماين ورخ 
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 للاتصال كاداة الإلكتروني البريد الثامن: الفصل

 الدردشة: حجرة اختيار

 تتناول حيث فيها. التفكير يمكنك التي الموضوعات كل الدردشة حجرات تتضمن

 على الأشخاص بعضها تساعد بينما السياسية القضايا مثل جادة موضوعات بعضها

 إلى يستمعون مراقبين بها الدردشة حجرات من والكثير نظرائهم. مع والتحاور الالتقاء

 المراقبين هؤلاء الغالب وفي به. المسموح الحديث حدود يتجاوز من ويطردون المحادثات

 ما غالبا الجادة الدردشة حجرات أن إلا معينة. أساسية بكلمات مطالبة برامج إلا ليسوا

 بموضوع المشاركين التزام من التأكد الأساسي هدفهم البشر، من بمراقبين تستعين

 القواعد. تجاوز وعدم النقاش

 كما الدردشة حجرة من والخروج إلى الدخول تستطيع أنك تدرك أن الضروري ومن

 هناك أن تجد فقد تدخلها. حجرة أول يف البقاء على يجبرك ما هناك فليس تشاء،

 حول النقاش لبدء الرئيسية الحجرة من تتفرع الدردشة حجرات من العديد

 الآخرين ويدعو حجرة بإنشاء الأفراد أحد يقوم عام وبشكل فرعية. موضوعات

 فسيتطلب سرية، أو خاصة تكون بحيث الحجرة بإنشاء المصمم قام وإذا لها للانضمام

 إليها. التوصل تستطيع لا قد مرور كلمة دخولها

 الزائرون قام التي المؤقتة الحجرات تتضمن مرة لأول الحجرات قائمة تظهر وعندما

 على بالماوس انقر فقط،Microsoft ب المسجلة الحجرات رؤية أردت وإذا بإنشائها

. Show only registered rooms  الاختيار تحديد مربع

 تستطيع أو الأوصاف كل وقراءة بالقائمة لأسفل التمرير يمكنك الأحوال كل وفي

 البحث. نطاق لتضييق خاصة عبارات أو أساسية كلمات عن البحث

٣٤٢



 للاتصال كاداة الإلكتروني البريد: الثامن الفصل

 تحديد هو استخدامه يمكنك والذي البحث نطاق لتضييق الهامة الخيارات ومن

 الى صفر من العدد يراوح افتراضيا نطاق بالحجرة الموجودين الأشخاص لعدد نطاق

 نفسك، مع التحدث تحب تكن لم ما واسع، نطاق هذا وبالطبع شخص.٩٩٩٩ فقرة

 الحجرات بشأن نفسك تقلق لا حتى ا يصبح بحيث الأدنى الرقم تغيير الأقل على ينبغي

 الفارغة.

 شرحه: سبق ما إيضاح في تسهم التالية والأشكال

. Show only registered rooms  الخيار تحديد مربع انقر اختياريا، ا

 الأوصاف. كل لقراءة بالقائمة لأسفل بالتمرير قم-٢

# بنجب ا
 ن=

 عءEa لة

2ريغ ع4Ttws ع ن
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 للاتصال كاداة الإلكتروني البريد الثامن: الفصل

٣Display Chat rooms that  الأساسية الكلمات أكتب حجرات، عن للبحث

.contain

.Also search in room topics  الخيار تحديد موقع حدد اختياريا،٤

 الحجرة. في الموجودين الأشخاص لعدد نطاق حدد اختياريا،٥

٣٤٤



 للاتصال كاداة الإلكتروني البريد: الثامن الفصل

 الدردشة. حجرات إحدى حدد-٦

Go انقر٧ Toالحجرة. لدخول 

،
 الآخرين: مع التواصل

 بالشاشة بها الموجودين الأشخاص عرض يتم الدردشة، حجرة في تصبح أن بمجرد

 بالحجرة، الوجودين الأشخاص مع للتحدث العلوي الأيمن الجزء في اغار وفي الرئيسية

 هو عمله عليك يجب ما أولSay زر انقر ثم الشاشة أسفل الموجود بالربع رسالة اكتب

 عليك ويطرحون الأفراد معظم بك سيرحب(Hello) التحية بإلقاء نفسك تقديم

 مناقشة هناك تكون -قد تنزعج فلا يفعلوا لم وإذا عليك للتعرف الأسئلة بعض

 عليك ينبغي فقد لذا الطبيعي. الاتصال دون حال قد بالشبكة التأخير أن أو مشتعلة

 المتكررة المحاولات بعد إجابة على تحصل لم وإذا المحاولة تعيد أن قبل قليلا الانتظار

٣٤٥



 للاتصال كاداة الإلكتروني البريد الثامن: الفصل

 أثناء أنه لاحظ والآن أخرى، حجرة عن البحث الأفضل من يكون فقد نفسك، لتقديم

 وتظهر جديدة، كاريكاتورية أشكال رسم يتم الحجرة في الموجودين الأشخاص حديث

 تفكرفي بك الخاصة الشخصية أن توضيح في ترغب وعندما حوارية. ببالونات كلماتها

 الشكل )انظرSay زر من بدلاThink زر انقر علنا، عنه تفصح لا ولكنها ما، شيء

 كانوا لو الأمركما فيبدو قراءتها، بالحجرة شخص كل بإمكان يكون وهنا التالي(.

 لاحظ الرجل جهاز من الشاشة الشكل يوضح سماعه. من بدلا الشخصية أفكار يقرأون

 في لذا جهازك. في الرجل بتحديد هي قامت بينما الشخصية إخار في المرأة يحدد لم أنه

 ولكن نفسه إلى يتحدث هو يظهر بينما إليه، تتحدث هي تظهر الكوميدية، اللوحات

 ترسل أن قبل الشخصيات بإخار بتحديده قم معين، شخص إلى متحدثاً نفسك لتعرض

 رسالتك.

 استخدامه ويتم بالحجرة الآخرين إلى للتحدث الثالثة الوسيلة هو الإجراء زر إن

 ثالث. غرف سرد إلى تحتاج عندما الحوار على يعتمد لا الذي للاتصال

 ذكره. سبق ما إيضاح في تسهم التالية والأشكال

 الشخصيات. وبإخار الرئيسية بالشاشة الحجرات في الموجودين الأشخاص يظهر ا-

٣٤٦



 للاتصال كاداة الإلكتروني البريد: الثامن الفصل

 الرسالة. اكتب-٢

 الرسالة. لإرسالSay زر انقر٣

Think  زر انقر٤

 بالوني. إخار في الرسالة تظهر٥

.Whisper  رمز انقر معين، لشخص خاصة رسالة لإرسال-٦

٣٤٧



 للاتصال كاداة الإلكتروني البريد الثامن: الفصل

.Action  زر انقر-٧

 باسمك. مستهلة الكاريكاتيرية. اللوحة أعلى في بمربع كلماتك تظهر٨

.Text  زر انقر الكاريكاتورية. الأشكال تتجاوز٩

٣٤٨


